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The Ohio Department of Education funds development of EMIS training materials
as part of the EMIS Alliance grant. There is an expectation that ITCs will utilize these
materials in training provided to your districts. That said, there are restrictions on
use of the EMIS Alliance materials as follows: Materials developed as part of the
EMIS Alliance program must be provided at no cost to your training participants. If
you utilize the EMIS Alliance training materials —in whole or in part — you must not
charge participants a fee to attend the class where the materials are used. Likewise,
you may not use the materials or any portion thereof in any event where a fee is
charged to attend. Exceptions must be approved in writing by the Department of
Education in advance of scheduling/promoting any event which may violate these
restrictions.

Questions regarding appropriate use of EMIS Alliance materials, or requests for
exception to the restrictions noted above, should be directed to Melissa Hennon
[Melissa.Hennon@education.ohio.qov].
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 Overview

* Teacher Licensure Course (TLC) Status Report

* Includes all courses reported to EMIS and the proper certification
status of the teacher of record

* |s generated for all EMIS reporting entities and updated nightly

» * |s used to provide data for Local Report Cards (LRC), certain state and
| federal funding, and for ODE program evaluation and planning

* This presentation will focus on troubleshooting the TLC Status
Report, which is generated during the Initial Staff and Course
(L) Collection
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. Certification Data on LRC

|

The LRC contains data from the Initial Staff and Course
Collection that is used to populate the school or district details

Your District's Teachers

Attendance Rate Average Salary Avg. Years of Experience Lead or Senior Teachers
94.2% $60,254 18 0
° L] L]
https://reportcard.education.ohio.gov A choosin | HighPoverty | Low Poverty
the District Schools Schools

Percentage of teachers with at least a Bachelor's Degree 100.0 0.0 100.0
Percentage of teachers with at least a Master's Degree 66.6 Q.0 70.5
Percentage of inexperienced teachers 3.6 Q.0 2.4
Percentage of inexperienced principals 33.3 0.0 16.7
Percentage of teachers who are not teaching in the subject or field for which the teacheris 0.8 0.6
certified or licensed
Percentage of teachers teaching with temporary or conditional credentials 0.0 0.0

Adistrict's high poverty schools are those ranked in the top quartile based on the percentage of the district's economically disadvantaged students.

Low-poverty schools are those ranked in the bottom quartile based on the percentage of economically disadvantaged students. A district may have EMIS
buildings in both quartiles, in just one quartile, or in neither quartile.
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TLCS Data Uses

* ODE Federal Programs Office to audit the use of Title | Funds to
generate the ESSA State Licensure Assurances Report
e 20##L_PRIN_ESSA_Licensure_Assurances_<file date>.pdf
* Arrived as a Received file in FY22 in February 2022
 Displays all core courses, by staff member, and building
* Report contains instructions and ODE contact information

* See EMIS Validation and Report Explanations > File Descriptions on the
ODE website for additional information

e ESSA requires schools and programs receiving Title | funds to ensure that
all teachers and paraprofessionals working in a program supported with
these funds meet applicable State certification and licensure
requirements

* Wrong staff name on ESSA report?

* two districts report the same state ID but with different names attached
* Incorrect name does not impact actual data since ODE only uses State Staff ID Alliance
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TLCS Data Uses, cont’d

* By the ODE Office of Educator Effectiveness to provide districts the
Equitable Access Analysis Tool to use for Title | equity planning
e Contains Percent and FTE of teachers who are not properly certified
e Same as last year, districts will access this via the SDC in January
| * Uses previous year’s data — FY22 reporting will be used by your district in FY23
* Questions — equity@education.ohio.gov

* Local equitable access planning requirement in the ED STEPS

* The tool allows educators to identify where, and to what extent, any inequities in access to
excellent educators exist

* https://education.ohio.gov/Topics/Teaching/Educator-Equity/Educator-Equity-in-Ohio/Local-Equity-Plan-1
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TLC Status Report

To access the TLC Status Report, select the Level 2 Reports link
. from the Staff and Course Collection — Initial (FY23)

,J Staff and Course Collection - Initial (FY23)
- FY23-L-Stf Crs Init: Collection required for all EMIS reporting entities. The initial staff collection includes staff employed any time in FY23 and st... *

Submissions: September 08, 2022 - January 31, 2023 (62 days till close)

,)‘\ ‘ Version: 6 From DD evel 2 Reports
[} |
| 1 Status: The collection was submitted yesterday at 03:05:35 PM by

. Submission Status: Processing Completed (yesterday at 03:05:38 PM)
18 Submission Number: 7 (attempt 1)
Actions: Start Collection

Submit Errors: Mone (has other errors or warnings}

Prepare Outputs: | 1 validations
Add Mew Scheduled Collection c View submission 7 Data >
Set Default Collection properties

/
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But first, let’s take a quick look here
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View Submission Data > Generate Review Data

Verify data in the Initial Staff and Course Collection

=enerate Review Data

Are there invalid records that need to

be corrected? Review Level 1 Validations.
N B ' F - "':L&.S_".'l

Contract Only Staff Record (CC).csv

Contractor Staff Employment Record (CJ).csv

Submission 22

valid Inwvalid Total

— —| that are preventing data
Mapped_Classroom_Code]

Staff Course Record (CU) from being reported?

Course Master Record ({ Are there ExcludEd Records

0

1819

Stafr DE'“GQE_IW:F Dormed f0TY FI¥,

630

sart_employmd Are there missing staff records?

Staff_Missing_Override_Record_(CP).csv

Staff Missing_Report.csv

Staff Summer Employment Separation Record [CL).csv

0

0

boo| Yo

1449
E”""’;”J' 0
sa7| 10

9

‘ZEE~ 14

0

swdentcoury Incorrect data = Incorrect TLC Report

123

166

| EE————

1857

639

794

46

31829

38433

Submission 21

valid Invalid Total

1833

629

779

31513

36549

26

10

15

281

358

1859

635

794

31794

26907
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TLC Status Report - Level 2

Collection Requests

Collection Status

Submissions = Progress = Reports @ Archives

——

Messages Resources @ Preferences

Data Feedback Reports and Files
Pre-Submission to ODE | Post-Submissje

evel 1 Details | Highlights and Recent

&ssing by ODE

Received Files Details

Level 2 Details

Level 2 Details

Choose the filter criteria then click the Show Reports link to generate the list of Level 2 reports matching these criteria. To see the option to Generate a single .zip file for all
reports (.csv), you must select a single Report Name, or select a single LEA and a single Collection Request or a single Category.

Collection Req

LEA: | Colonel Crawford w | st: | FY23-L-Stf Crs Init ~ |

LEATRN:| | Report Nage: | (TLCS-001) Teacher Licens: v |

Processed on or after: : rmm/ aUT e

with Data Only: [ ] Exclude reports with 0 rows

Data Set: School Year:
ast Activity Within:

ast Updated on or after: : (mm/dd/yyyy)
Report Name includes: :

Category: | All

O Show closed collections

Group By: @ cojlection Request ) LEA O Level 2 Report J Category O Data set O None

File Format: O pytmL ® cov O cov

by Building IRN O

-/ CSV by Other Field (see Field Na-l.me in the table below) Verify that fi Ite rs a re correCt
then select “Show Reports”

Show Reports estore Defaults | Reset Date textboxes

(Total Count: 1)
Collection Request / Report Name Fatal Critical Warn Info Total Catego Data Field Process Date Last Upd Date Submission L
q p egory Set Name p Page
W Staff and Course Collection - Initial (FY23) (2023L15TR) (Count: 1)
(TLCS-001) Teacher Colonel Crawford Loc_046516 11 0 0 525 536 Staff L 11/20/22 00:05 11/30/22 00:05 0 Unknown Help
Licensure Course Status e
Generate a single.zip file for all reports | Export report information to a .csv file
EMIS
12/08/2022
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~ Formatting the TLC Status Report

* Open the (TLCS-001) Teacher Licensure Course Status Report
* Wrap text header row

* Freeze top row
* Expand all columns
* Apply filters

* Better yet, use your macro! EMIS Alliance Excel

* https://community.mcoecn.org/display/EM/FY22+EMIS+Alliance+Using+Excel+to+Troubleshoot+EMIS+Data

* https://community.mcoecn.org/display/EM/FY21+EMIS+Alliance%3A+Using+Excel+to+Troubleshoot+EMIS+Data

* https://community.mcoecn.org/display/EM/FY20+EMIS+Alliance%3A+Using+Excel+to+Troubleshoot+EMIS+Data
* https://community.mcoecn.org/display/EM/FY19+EMIS+Alliance%3A+Using+Excel+to+Troubleshoot+EMIS+Data

https://community.mcoecn.org/display/EM/EMIS+Alliance%3A+FY18+Using+Excel+to+Troubleshoot+EMIS+Data

\ 12/08/2022
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QUiCk Check * Are you using the most recent version

, of the report?
The TLC Status Report is e TLC

updated nightly and should
be reviewed throughout the
Initial Staff and Course

e ESSA State Licensure Assurances
* Equity Analysis

Collection. Data on your * Have you corrected Level 1 Validation
report could appear based on errors, excluded records, and missing
another entity’s reporting, so staft?

review the report even when * Are you able to open and format your
you are not reporting any TLC Status report?

changes.
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Understanding
the TLC Status Report

vvvvv
Alliance



TLC Status Report Data

e Data from the following collections are used to generate the TLC Status
Report

Staff and Course (L) Collection - Initial

Final Calendar (C) Collection

Beginning of Year Student (S) Collection
Midyear Student (S) Collection

SOES Beginning of Year Student (S) Collection
SOES End of Year Student (S) Collection

* Verify data is correct and complete in ALL noted collections

* Report is 1generated nightly with data submitted by 5pm throughout the
Initial Staff and Course Collection

* The TLC Status Report is finalized at the close of the Initial Staff and Course
(L) Collection

EMIS
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TLC Status Report Data

. Contains one row per Local Classroom Code

* First 11 columns include:
* Location IRN of the building where the course is being taught
e Subject Code, Description, and Local Classroom Code
» Teacher of Record and State Staff ID
* Blank or incorrect staff name
e CJrecord issue — not reported by another EMIS reporting entity (example: ESC)

e Could be due to upper- and lower-case letters in state staff ID - Verify ID

* Create helpdesk ticket to ask ODE about blank or missing names if needed
A B C D E F G H | J K

RPT DEST LOCATION RSEVERITYY SUBJCT CHR STATE LAST FIRST MIDDLERLOCAL CLASSRM
RN LOC IRN NAME CODE  SUBICT DESCR 1D NAME NAME NAME QJCODE
404040 222222 High SchoolfF 145005 Information Technology BNOH142 LAST FIRST M. 751-01
404040 222222 High SchoolfF 145005 Information Technology JOH142 LAST FIRST M. 751-02
404040 222222 High School 145005 Information Technology BNOH142 LAST FIRST M. 751-06
404040 222222 High SchoolfF
404040 222222 High School
404040 222222 High School
404040 222222 High School

EMIS

Severity Codes align with Result Codes which |
will be discussed in upcoming slides S
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- Verify Staff and Courses

73 * Do not focus on errors only; review the entire report for accuracy and

completeness

* Are all building IRNs appearing on the report?
* Are all teaching staff appearing as they should?

* Are all courses for each building appearing on the report?

404040 222222 High Schoolf F
|

A B C D E F G H | J K
RPT DEST LOCATION § SEVERITYy SUBICT CHR STATE LAST FIRST MIDDLEgLOCAL CLASSREM

T [JRN LOC IRN NAME CODE CODE SUBICT DESCR 1D NAME NAME NAME QCODE
2 404040 222222 High Schoolf F 145005 Information Technology BNOH142 LAST FIRST M. 751-01
3 404040 222222 High Schoolf F 145005 Information Technology BNOH142 LAST FIRST M. 751-02
4 404040 222222 High Schoolf F 145005 Information Technology BOH142 LAST FIRST M. 751-06
5 404040 222222 High Schoolf F 145005 Information Technology BNOH142 LAST FIRST M. 751-07
6 404040 222222 High Schoolf F 150700 Geography U101 LAST  FIRST M. H5T412-01
7 404040 222222 High Schoolf F 153001 Financial Literacy U101 LAST  FIRST M. FIN LIT-01
8 153001 Financial Literacy U101 LAST  FIRST M. FIN LIT-02

\ 12/08/2022

* Remember that total courses are the denominator for Local Report Card
staff percentages, so it’s important that every course is accounted for
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} Teacher of Record

* The teacher who appears on the TLC Status Report is based on
e Teacher with greater amount of time teaching the course

* Multiple teachers teaching the same amount of time
* Uses first teacher the report finds who is properly certified

* If none are properly certified, the report uses the first teacher it comes to
P * It could change from report to report depending on the processing order

* No proper credential found
» Uses first teacher reported on the course

* See ODE ITC EMIS Training November 2021 & 2022 for
additional information

* https://education.ohio.gov/Topics/Data/EMIS/EMIS-Resources/EMIS-
Training

EMIS
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Course and Calendar Dates

e Dates are used to determine a “course calendar”
e Grade Schedule (DL) Record - First and Last Day of School
e Course Master (CN) Record - Course Start and End Date
e Staff Course (CU) Record - Staff Course Start and End Dates
e Student Course (GN) Record - Course Enrollment Start and End Date

* The “course calendar” is then used to determine
» Teacher who was with the course the longest
e Students who are counted as being in the class
* Location IRN is used for course calendar assighnment

* Misaligned dates can cause teachers to appear as not properly certified

EMIS
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Location IRN

The building IRN where course is being taught

* District IRN should not be reported as the Location IRN

* Applies to LEAs that have both district and building IRNs
* Traditional Districts
* Refer to reporting instructions in the EMIS Manual for Location IRN
in section 4.2 Course Master (CN) Record
* Filter TLC Report for Location IRN
* Unselect local building IRNs

* Verify Location IRN’s reported outside of District
* Local district IRN should be changed to building IRN (when applicable)

EMIS
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} Location IRN

A few exceptions (not a complete list)

* IRN of college who is granting credit for CCP course

* For CCP Course with delivery method of CP report the IRN of the
location of the course per the CTE-26

* IRN of the location of the JVSD satellite course
* IRN of the building associated with the preschool license

* See additional reporting instructions for the Location IRN in the 4.2
Course Master (CN) Record section of the EMIS Manual

EMIS

iy
Alliance



|

TLC Status Report Columns

' Moving to the right, the next set of columns L through P contain
| * Result Codes with Descriptions

* Proper Certification Flag (Yes or No)

 Calculated TLC IRN (derived from reported data)

e LEA IRN (IRN of the LEA reporting the course)

L M N O P Q R S T
PROPER DLVR EDUC  STDNT
| |REsuLT Calculated TLC IRN is CERT | CALCTLQ CRCULM METHOD OPTION POP
‘{' ! CODE RESULT CODE DESCR FLAG IRN LEA IRN] CODE CODE CODE CODE
[ [l |TLOO06 Courseis Not Properly Cer 1 N ok ok 404040 VM FF NO RG
:9\\ ‘\‘ TLOOD6 Course is Not Properly Cer derlved from reported data \ M s 404040 VM FF NO RG
!?;(‘ | |TLOO06 Course is Not Properly Certified as no current valid credential or incorrect student population ok o 404040 VM FF NO RG
’5{’5 ," | TLO006 Course is Not Properly Certified as no current valid credential or incorrect student population K o ko 404040 VM FF NO RG
4 ’?' TLOO0O6 Course is Not Properly Certified as no current valid credential or incorrect student population A ‘222222 404040 OT FF NO RG
ﬁ l TLOO06 Course is Not Properly Certified as no current valid credential or incorrect student population N 222222 404040 OT FF NO RG
{ TLOOD6 Course is Not Properly Certified as no current valid credential or incorrect student population N 404040 OT FF NO RG
| TLOO09 Course is Not Properly Certified as students enrclled are outside the grade range for the relevant credential [N 404044 OT FF NO RG
] : TLO002 Course is Properly Certified and is not a core course Y 404044 OT FF NO PR
‘ TLO00D2 Course is Properly Certified and is not a co . . Y 404040 OT FF NO RG
\ LEA IRN is entity o

\'12/08/2022
\

reporting the course |
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TLC Status Report Columns, cont’d

Course elements — appear on the report for ease in troubleshooting

* Curriculum Code

* Delivery Method Code

* Education Options Code

e Student Population

* Population of students for whom the curriculum is intended and not about the students who are actually enrolled

Different errors for the same staff member over multiple reports

* Both result codes (TLxxxx) could apply

* Error can change due to the order in which things are processed

e Could potentially change from report to report

L M N 0] P Q R S T
PROPER DLVR EDUC  STDNT
RESULT CERT CALCTLC CRCULM METHOD OPTION POP
CODE RESULT CODE DESCR FLAG IRN LEA IRN JCODE CODE CODE CODE
TLO0O06 Course is Not Properly Certified as no current valid credential or incorrect student population W] Mk 4040404V M FF NO RG
TLOOOE Course is Not Properly Certified as no current valid credential or incorrect student population N ok 4040400VM FF NO RG
TLODO9 Course is Not Properly Certified as students enrolled are outside the grade range for the relevant credential N 222222 40404040T FF NO RG
TLODOZ2 Course is Properly Certified and is not a core course Y ko 404040007 FF NO PR
TLO0D2 Course is Properly Certified and is not a core course Y A, 404040401 FF NO RG
EMIS
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Special Ed vs Regular Student Population

Student population reported based on the content/structure of the course
e If modified for special education population, report with an SE student population
e Teacher must hold a special education license to appear as properly certified for an
SE course
e Certification and Licensure Search does not include courses coded with a student
population = SE
e As faras the TLC Status Report is concerned, someone with a special ed license can teach any
| subject in a special ed classroom

e If not modified for special education population, report with an RG student population
e Teacher must hold a regular education license to appear as properly certified for an
RG course

e Do NOT modify student population to remove an error

e Always report “What is” EMIS
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" TLC Status Report Columns, cont’d

Columns U through AJ contain

e Count of students enrolled in the course by state equivalent grade
level (both regular education and students with disabilities)

U W W X Y i AA AB AC AD AE AF AG AH Al Al
TWENTY
FIRST SEC THIRD FOURTH FIFTH  SIXTH SEVNTH EIGHTH NINTH TENTH ELVNTH TWELTH THRTNTH THIRD
KDG GRADE GRADE GRADE GRADE GRADE GRADE GRADE GRADE GRADE GRADE GRADE GRADE GRADE GRADE
PSSTDNT STDNT STDNT STDNT STDNT STDNT  STDNT STDNT STDNT  STDNT STDNT STDNT STDNT  STDNT  STDNT STONT
COUNT COUNT COUNT COUNT COUNT COUNT COUNT COUNT COUNT COUNT COUNT COUNT COUNT COUNT COUNT COUNT
0 0 0 0 0 0 0 0 0 24 0 0 0 0 0 0
0 0 0 0 0 0 0 0 0 25 0 0 0 0 0 0
0 0 0 0 0 0 0 0 0 27 0 0 0 0 0 0
. . 0 0 0
| Cells can be blank if there are no students enrolled in the course | : R
. 15 0 0
Or the students are not being populated onto the report 18 0 0
9] U U U U U U U U U 9] U U 13 0 0
7 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
0 0 17 0 0 0 0 0 0 0 0 0 0 0 0 0

\
\
\ 12/08/2022
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TLC Status Report Columns, cont’d

Far right columns contain

* Counts of students with disabilities and the percentage of those students
in the course

* Credential Course Disability Indicator Code with Description
* Reported TLC IRN, Check Type Code and Provider IRN

AK AL AM AN AO AP AQ
RED
g | OURSE
N | DISAB  TOTAL [DISAB CHECK
| STDNT DISAB |IND RPTD TLC TYPE PRVDR
‘ » COUNT PCT ODE CRED COURSE DISAB IND DESCR IRN CODE IRN
5‘ 1] 0 0 Student Population of PR or RG. wakwRx R H
" 4 16 ¢ Student Population of PR or RG. HAEEEE R Aok
5 3 11.11f Student Population of PR or RG. HAEEEE R Aok
| i 7 26.92F¢ Student Population of PR or RG. koK R kR ok
p \ 1 125F Student Population of PR or RG. 222222 R kR ok
| \ 1 6.67¢ Student Population of PR or RG. HAEEEE R Aok
\ 2 11.11f Student Population of PR or RG. wRRRAK R A EM"‘_"
| 12/08/2022 3 23.08f Student Population of PR or RG. okl R e ok ".ﬁ' 24
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- Reported TLC IRN

* IRN of the building where this course will be used in the
calculation of the percentage of core courses taught by
properly certified/licensed staff

- * Local, exempted village, or city school districts can report the
. IRN of one of their own buildings but should not report their
| district IRN for the TLC IRN

e Refer to EMIS Manual 4.3 Staff Course (CU) Record to review
all reporting instructions for this element



|
|
|

" Core or Non-core?

EMIS Manual section 4.7 Subject Codes | A value in this column
Ohig | 2ertmen oo o indicates CORE subject

area while “—”
indicates a non-Core
Sret ] core sebtert subject code

Business Education Section

Table 5. Business Education (Non-Career Technical) Codes (03xxxx)

Subject Areafor | Area (for
Code |Description Credit | proper cert)
030100 |Accounting BUS =
Instruction focuses on the management of a company’s financial re- \

' ? sources including the accounting cycle, financial statements, and in- \ Non_co re Su bject Code

terpretation and use of financial data. Content should be based on
‘ National Business Education Association (NBEA) content standards.
‘ Only grade 9-12 courses based on standards from the 9-12 grade band
‘ of NBEA Standards are eligible for high school credit.

030500 |Business Mathematics BUS, MTH Mathemati‘ci
Students develop the skills necessary to solve mathematical prob- N
lems, analyze and interpret data, and apply sound decision-making CO re Su bject COd es
skills in business. Content should be based on National Business Edu-
cation Association (NBEA) content standards. Only grade 9-12 courses
based on standards from the 9-12 grade band of NBEA Standards are
eligible for high school credit.

030600 |Business Communications BUS, ENG JEnglish
Students master the oral and written communication skills essential
to interacting effectively with people in the workplace and society.
\ Content should be based on National Business Education Association
“'\ (NBEA) content standards. Only grade 9-12 courses based on stand-
ards from the 9-12 grade band of NBEA Standards are eligible for high EMIS
school credit.

\'  12/08/202 W 26
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Reported TLC IRN, cont’d

e Report ****** for non-core courses and for core courses where

e Curriculum element s

* OC — Expert Contracted from Outside Company/Organization for Credit Flex,
PS- College Credit Plus, or Pl — Postsecondary Instructor (not CCP)

 or Delivery Method is

 CC—Correspondence Course, ET — Educational Travel, or OL - Online, and
Educational Option is Yes

* or Delivery Method is

* ID — Interactive Distance Learning, IM — Internship/Mentorship, TO — Test Out,
or Cl — Computer as Instructor

e or Student Population is

D8 — Preschool Special Education, DP — Preschool Special Education
Hearing/Visual, or PR — Preschool General Education

EMIS
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Reported TLC IRN, cont’d

* When contracting a teacher of record from an EMIS reporting
entity

* Two common situations-

* Contracted teacher is teaching only your students in a
course in your building

* Report the building IRN as the TLC IRN (same as Location IRN)

* Contracted teacher is teaching students from multiple

districts

* Report the district IRN of the contracted entity (Location IRN is
building where class is being taught)

* See 4.3 Staff Course (CU) Record section of the EMIS Manual
for additional reporting instructions

EMIS
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Reported TLC IRN, cont’d

* Courses reported with a TLC IRN of another EMIS Reporting LEA
should appear on both LEA’s TLC Status Reports when reported
correctly

* Contractor Staff Employment (CJ) Records are required to be
reported by the entity employing the staff member but are
not needed for the course and staff to appear on both
contracted entity’s TLC Status report

* Work with contracted EMIS Reporting entities to verify that
teachers and their courses are appearing correctly

* Reporting Example
* District A reports courses
e ESC reports CJ record EMIS
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Staff Provider IRN

Reported on the Staff Course (CU) Record

e District IRN of the EMIS Reporting entity who employs the contracted
staff

e Cannot be an IRN of a Non-EMIS Reporting entity

| * Should be reported as ****** if the staff member is not being
contracted from another EMIS reporting entity

* Must be reported when the entity reporting the course is not
reporting Staff Demographic (Cl) and Staff Employment (CK) records
for the staff member

* Filter on Staff Provider IRN to verify accuracy of reporting

* Unselect ******
* Verify remaining Staff Provider IRN for accuracy EMIS
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Derived Elements on TLC Status Report

e Calculated TLC IRN

* In most cases the calculated TLC IRN will match the TLC IRN reported for
core courses

e could be set to match the Location IRN when TLC IRN is reported as
kxxkx* or reported with an IRN that is not a valid public school

* non-core courses will be set to ******

* Credential Course Disability Indicator

 derived from reported student population and students with disabilities
who are enrolled in the course

e are used to determine the Check Type
* Check Type Code

e indicates the credential check that was used

EMIS
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Credential Course Disability Indicator A

Filter on A - Student Population of DP or SP

* DP-Preschool Special Education Hearing/Visual
» SP-Special Education K-12 Hearing/Visual

| * More than 50% of the students in the course must have a disability
| condition
* Of these students, more than 50% must have a disability condition of

e 1 (Multiple Disabilities-Other than Deaf-Blind)

e 2 (Deaf-Blindness)

e 3 (Deafness-Hearing Impaired)

* Can be all 3s or some combination of these three disability conditions

e Check Type Code is S — Special Situation Check

EMIS
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Credential Course Disability Indicator B

Filter on B - Student Population of DP or SP

* DP-Preschool Special Education Hearing/Visual
» SP-Special Education K-12 Hearing/Visual

* More than 50% of the students in the course must have a disability
| condition
* Of these students, more than 50% must have a disability condition of
e 1 (Multiple Disabilities-Other than Deaf-Blind)
* 2 (Deaf-Blindness)
* 4 (Visual Impairments)
* can be all 4s or some combination of these three disability conditions

e Check Type Code is S — Special Situation Check

EMIS

iy
Alliance



Credential Course Disability Indicator C

Filter on C - Student Population of D8 or SE
* D8 - Preschool Special Education
* SE - Special Education K-12
* More than 50% of the students enrolled in the course must have a
disability condition
* Course cannot fit into codes A or B
* Check Type Code is S — Special Situation Check

EMIS
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Credential Course Disability Indicator D

Filter on D - Student Population of DP, D8, SE, or SP
* DP - Preschool Special Education Hearing/Visual
* D8 - Preschool Special Education
 SE - Special Education K-12
* SP- Special Education K-12 Hearing/Visual
* 50% or fewer of the students enrolled in the course have a
disability condition
* Check Type Code is R — Regular Check

EMIS

ol [y

! -»
Alliance



Credential Course Disability Indicators E and Z

Filter on E - Student Population of GA or GE
* GA - Gifted Education in arts delivered by trained arts instructor K-12
e GE — Gifted Education K-12
* Check Type Code is S — Special Situation Check

Filter on Z - Student Population of PR or RG
* PR —Preschool General Education
* RG — Regular/General Education
* Check Type Code is R — Regular Check

Filter on X — Does not fit into categories A, B, C,D, E, or Z
* Rare
* Means none of the above
 Verify proper certification flag has been set properly

EMIS
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Regular Check Type Code R

Filter on R — Regular Check

* Majority of courses
e Educational Option = No
e Student Population
| * RG - Regular/General Students K-12
| * PR — Preschool General Education
* Delivery Method = FF — Face to Face and OL — Online
e Curriculum code
e AP — Advanced Placement
* |A — International Baccalaureate AB INITO
e OT — Curriculum not specifically covered by another option
e Career Tech Codes

EMIS
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} Special Situation Check Type Code S

Filter on S — Special Situation Check
* Educational Option = No

e Student Population
| * DP - Preschool Special Education Hearing/Visual
P * D8 - Preschool Special Education
‘ * GA - Gifted Education in arts delivered by trained arts instructor K-12
* GE - Gifted Education K-12
e SE - Special Education K-12
* SP - Special Education K-12 Hearing/Visual

EMIS
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Any Certification Check Type Code A or N

Filter on A — Any Certification Check
* Educational Option = YS *OR*

* Delivery Method of
* Cl — Computer as Instructor
* |[D — Interactive Distance Learning
| * IM — Internship/Mentorship
} Filter on N — No check required
| e Courses with Curriculum Element
e OC — Expert Contracted from Outside Company/Organization for Credit Flex
* Pl - Postsecondary Instructor
e PS —College Credit Plus

* Educational Options = YS

e Delivery Method =TO, ET, IS, IM, OT (community service, work-based
learning) EMIS
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Community School Check Type Code C

Filter on C — Community School Course

* Traditional district regular checks are run and if the Properly
Certified Flag is set to N, additional checks are run that allow for any
regular teaching license or any substitute license

* This does not apply to special education checks

EMIS
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Quick Check

The TLC Status Report uses a
wide variety of data from
many different collections.
Taking time to verify that
EMIS data is correctly
reported will result in a
clearer, more accurate TLC
Status Report.

* Have you reviewed your EMIS data
for accuracy and completeness?

 Are all courses and teaching staff
appearing on the report?

* Have you shared the data with
staff who can assist with data
verification?

EMIS
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CORE Educator Search
and Certification and
Licensure Search
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llllllll



CORE Database

The TLC Status Report

* looks at each course and at data regarding the teacher’s current
credentials from the CORE database

» determines if the staff member is appropriately credentialed to
teach the
* subject code
» student population
» grade level(s) of the students scheduled in the course

e Use the CORE Database/Educator Search to review teacher
licensure information

EMIS
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\
" Educator Licensure & Records > Educat
https://core.ode.state.oh.us/Core4/ODE.CORE.Lic.Profile.Public.Ul/

OME A TATE AGENCIES ONLINE SERVICES Ohio.gov

‘ - Department
Ohlo ’ of Education ‘ *» LOGIN a sion Timeout:00:29:46

EDUCATOR PROFILE ~ EDUCATOR CONDUCT SEARCH COPRT Tiomt

Access publicly
from this page

= S————

OR click either link
to log into OH|ID to
access the CORE App E—

Educator Profile

Q Educator Search

Educator State 1D: Last Name: First Name: Middie Name: Birth Year:

|OR

CORE App
i\
l | Educator Licensure and
' Records (CORE)
Apply, renew, and maintain licenses EMIS
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Demographic Information

2 Educator

Copy Educator Info & | Print Educator Summary 21 | Back to search %

Educator State ID: Full Name: Birth Year:
OH1 . . .
Credentials are listed along with
_ additional information below
@ Credentials

+* CREDENTIAL STATUS EFFECTIVE DATE ISSUE DATE EXPIRATION DATE CREDENTIAL NUMBER
= 5 Year Professional Adolescence to Young Adult (7-12) Licens l m I 07/01/2019 01/16/2019  06/30/2024 21656259
Teaching Fields Issue Date
Integrated Mathematics [110094] / 01/16/2019
= 5 Year Professional Adolescence to Young Adult (7-12) License 07/01/2014 05/22/2014 06/30/2019 21000670
Teaching Fields Issue Date
R 05/22/2014
;| Note the active license/certification 0012012 03152012 06/30/2015 20748138
1| and teaching fields

| "\ 12/08/2022 .ﬁ‘ 45
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\‘ Educator Credential Data by District

;
i

In the Educator Profile dropdown menu,
SEIeCt Educator Data by DiStriCt HOME ABOUT ODE  STATE AGENCIES  ONLINE

Oh - Department
10 | o Education 4

EDUCATOR PROFILE EDUCATOR CONDUCT SEARCH CORE HOME

» Educator Search

» Esigner Data Search

ial Data by District

» Educator Data by Dist

Re

9 Final Staff Course Collection Latest Version

Organization Search

Organization Name or IRN:

UaiE02 - Columbus City School Distnct - Public Distnct el S Res
o e L \ Choose a school and then
Start Typing Either an Organization Mame or IRM and Click on "Salect’ “SEIeCt” to download a /
spreadsheet of educator data

EMIS
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Teacher with Two Licen

# Credentials

SES

Click to Hide ==

+* CREDEMNTIAL STATUS EFFECTIVE DATE ISSUE DATE EXPIRATION DATE CREDEMTIAL NUMBER
= 5 Year Professional Career Technical (4-12) License I m 07/01/2020  07/01/2021  06/30/2025 | 22018300
I Teaching Fields I Issue Date
Business Information Systems [140200] 07/01/2021 H
Endorsements Issue Date Thls teaCher had a one yea r
Teaching English to Speakers of Other Languages (Prek-12) [#50275] 07/01/2021 H H H H
| license that is only valid in
= 5 Year Professional Elementary (1-8) License .m. 07/01/2020 05/15 . . .
this district as wellasa 5
I Endorsements I Issue Date
Com puter!TechnDIGEy (Prek-12) [111770] 05/15/2020 yea r Ilcense
= 5 Year Professional Career Technical (4-12) License Expired 07/01/20186 03/2372076 0673072027 21246308 |
Teaching Fields ssiepate | NOte any limitations, teaching
Business Information Systems [140200] 03/23/2018 .
Endorsements sseepate | fjelds, or endorsements that
Teaching English to Speakers of Other Languages (Prek-12) [#50275] 05/18/2020
= 1 Year Supplemental Career Technical Workforce Development License Expired 07/01/2015 may be IISted
I Valid In Organization: Willard City [045098] I
Teaching Fields Issue Date
Business Information Systems [140200] 07/10/2015
Limitations Issue Date
Limited To 2 Renewals [B88002] 07102015

12/08/2022
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Certification and Licensure Search

» EMIS Basics

» Documentation

1
l QUICK LINKS
,\‘

» EMIS Reporting Responsibilities

Home > Data > EMIS > Certification and Licensure Search

READ ME
Certification and Licensure Search

This resource was created to assist districts in validating data that appear on the Teacher
Licensure Course (TLC) Status Report generated by EMIS. For a list of the current subject codes

please see EMIS Manual Section 4.7. This search has been updated for FY22.

» Resources

Link 2

» EMIS Technical Documen

Search for Regular Teaching Certificates and Licenses

» EMIS Advisory Council

» EMIS Learning Library

» Certification and Licensure Search
» SLDS Grant Project 3

EMIS Newsflash - December 1,
2021

EMIS Newsflash - November 19

- Link 1

This search is for situations where a course master has been submitted and the student
population is PR or RG (i.e., regular education courses). Every permissible combination is not

Student Population
PR - Preschool General Education
RG — Regular/General Students K-12

found in this search. For instance, situations in which a teacher is required to have multiple

teaching fields or multiple credentials do not appear.

Note that the general rule for elementary credentials (i.e., Kindergarten-Primary (KP),
Kindergarten-Elementary (KE), Elementary (EL), Early Childhood (EC)) allows the teachers who
hold these credentials to teach any course within the relevant grade range. These situations
are not reflected within this search tool. An exception to this rule is for those initially hired on
or after July 1, 2013, to teach physical education. These teachers must be licensed in PE and ar¢
included in this search tool.

For questions regarding Invalid_Cert reports, please contact EMIS via the helpdesk. For
questions regarding teacher assignments, please contact the Office of Educator Licensure.

OR

Search for Special Education Teaching Certificates and Licenses

EMIS Newsflash - November 11,
2021

This section is for courses reported with student populations of DP, D8, GA, GE, SE, and SP (i.e.,

special education courses).

Student Population

DP - Preschool Special Education
Hearing/Visual

D8 — Preschool Special Education
GA - Gifted Education in Arts...K-12
GE - Gifted Education K-12

SE — Special Education K-12

SP — Special Education K-12
Hearing/Visual

EMIS
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Link 1 — Special Education

Special Education Certification Information

hio.gov | Jepartment - Student Population

Home > Data > EMIS > Certification and Licensure Search > Teaching SE - SpECiaI Education K'12
> Re Course Search Panter Friendly Version . .
e READ ME SP — Special Education K-12
f:::f::m —_ Special Education Teaching Certificate & License Search Hearing/VisuaI
(for courses with student populations of SE or SP) <
About ODE

State Board of Education This section is for those teachers reported with position code 230 and assignment area 999414 <

Media Assignment area 999414

General Rule: Any teacher holding an education of the handicapped certificate (EH) or an intervention specialist
license (IL or ES) can teach students—at the grade levels for which the teacher is certificated or licensed—with any

gisabilty. Special Education K-12

"Exceptions:

= Any SE or SP course that is comprised of g/l hearing impaired students must be taught by someone certificated
or licensed to teach hearing impaired students. This includes the following

EH 196010, 19€015, 196070 (grades K-12)

IL 196116 (grades P-12) \ General RUIe

L]
Any SE or SP course that is comprised of alf visually impaired students must be taught by someone certificated a n d EXCE ptlo n S

or licensed to teach visually impaired students. This includes the following /
EE 196110 (grades K-12)

IL 196109 (grades P-12)

\ 12/08/2022
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Link 2 - Teaching Certificate & License Search

Click on the Cert/Lic. Type link License Types

to see a Iist of License Types AD  Adolescence to Young Adult (7-12)
= Depaftment . . . AE Adult Education
Al Educational Aide
Ohio.goV | ortiucaton (this is not a complete list) A Bl
_ Home > Data > EMIS > Certification and Licensure Search > Teaching AM  Student Monitor
T .| AS Administrative Specialist
> Regular Course Search Printer Friendly Versior]
— CheckType: 0 AT  Technologist
= s’“w AU  School Audiologist
: Teaching Certificate & Licens¢ Search L
& SAFE ACCOUNT SIGN IN BM  EAS - Business Management
These are individuals for whom a course master ha ed, i.e., with ppsition code 230 and assignment areal CH  Comprehensive High School (7-12)
About ODE Q999370 or 999300. O CR  EAS - School-Community Relations
State Board of Educati CcT Career Technical (4-12)
Media arch for Valid Subjects by CW  Career Technical Workforce Development
DS  Designated Subject (Grades K-12)
Seal_'ch for Valid Certificates/Licenses b l Select Type Vl DS Designated Subject (4-12)
: EA EAS - Educational Staff Personnel Administration
[: OR & Codes (up to 6): \ EC  Early Childhood (P-3)
ED EAS - Educational Personnel
2 EH Education of the Handicapped (K-12)
Submit EL Elementary (1-8)
° Submit EP Elementary Principal (K-8)
999370 - General Education K-12 ER  EAS - Educational Research
o ES Early Childhood Intervention Specialist (P-3)
and 999800 Career-Technical GE__General Education
bt of Public Instruction | Contact ODE | Qhio Home |
| Programs/Career Pathways EMIS

\ 12/08/2022 .ﬁ“ 50
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Search for Valid Subjects

\ Search by Certification/

| e e Teaching Certificate & License Search License Type and Teaching

| hese are individuals for whom a course master has been submitted, |.e., with position code 230 and assign FiEIdS and Endorsements
About COE 99370 or 999800

Media | | Search for Valid Sub}ects by /

Search for Valid Certificates/Licenses by

Subject Code (EMIS Manual Section 4.7): Centlic. Type: | AD v 1/
| OR & Codes (up to 6): | 150004

| Submit |
%Submn“;
| ~—r Results are a |I.St of su!o;ec.t codes and
| B s grades that this combination of
| 150004 - | Certification/License Type and codes
/alid Course is properly certified to teach
i | SuectCodelsy |  Grade(s)
" ’\ FbO"‘" exceplions may exist g: Wi Hore [0 | 7;7 ré Se
‘ 91"9.’7\""1‘
\ 031800 | 7-12 | EMIS
\ o ; 150100 { 7-12 ‘

N
I .
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Search for Valid Certificates/Licenses

Teaching Certificate & License Search
These are individuals for whom a course master has been submitted. i.e., with position code 230 and assignment

About ODE area 999370 or 999800.

State Board of Education
Media Search for Valid Subjects by

. SAFE ACCOUNT SIGN IN

Search for Valid Certificates/Licenses by !
Subject Code (EMIS Manual Section 4.7): Cert./Lic. Type: |Select Type V|

OR & Codes (up to 6):
Search b / Submit . .pe .
Y Results are lists of certificates/licenses

Subject Code along with teaching fields and grade levels
— that can teach this subject code
ml £13U
Cert. Type Cert. Code(s) | Grade(s) Lic. Type | Lic. Code(s) Grade(s)
Some exceptions may exist. Click Here to view these Some exceptions may exist. Click Here to view these
exceptions exceptions
CH 130175 7-8 AD 130100 7-12
HS 130000 7-12 AD 132010 7-12
HS 130100 7-12 AD 132020 7-12
HS 130200 7-12 AD 132030 7-12 EMIS
7 ¥

HS 130301 -12 AD 132034 -12 - "
CRaW/aVaW o Vatatal '&‘ 2
\ 12/ U0] ZUZ2Z "’B 3




Quick Check

The TLC Status Report checks
against the CORE database to
determine if a teacher is
properly certified to teach a
specific course. Searching the
database can aid in
troubleshooting the report.

* Are you able to use the CORE
Educator Search Tool to view
certification data?

* Can you search using the
Certification and Licensure Search
by certification or subject code?

* Are you involving your district’s
Human Resources staff in this
process?

EMIS
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TLC Status Report Result Codes
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- Properly Certified Result Codes

* Filter on TLC Result Code TL0O001 (Informational)

* Core Course
* Proper Cert Flag =Y

. * Filter on TLC Result Code TL0002 (Informational)

| * Not Core Course
* Proper Cert Flag=Y

* Verify the data to be correct and complete



Not Properly Certified - No Students in Course

Filter on TLC Result Code TLOOOS5 (Critical)

e Student Grade Count columns for this course will contain blank
values

* Verify that no students are enrolled in the course
* These courses will not negatively impact the LRC and can be reported,
however, the row will remain as a critical

* These courses could negatively impact CTE funding. If this is a future term
course, schedule students into the course or you will need to request an
override from CTE if it is not CTE FTE funded

EMIS
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Not Properly Certified - No Students in Course, cont’d

Continue filtering on TLC Result Code TLOO0O5 (Critical)

* Are there students being reported as enrolled in the course?

* Check the dates to be sure they are aligned
* Calendar start and end dates

e Uses the most common calendar dates for the majority of students in
the course

e Course Master (CN) Record start and end dates
 Staff Course (CU) Record start and end dates
* Student Course (GN) Record enrollment start and end dates

* If there are truly no students enrolled in the course at any point during
the school year and this is not a CTE course, then result code can be
ignored

EMIS
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Not Properly Certified — Credential/Course

No Current Credential or Incorrect Student Population

Filter on TLC Result Code TLO0OG6 (Fatal)

e Staff not certified to teach this subject code or student
population
* Check certification to see if they can teach the subject code

* Check the student population, is it correct?

* Check the students who are enrolled in the course to verify that
they align with the student population element
* Filter by that staff member to see all courses and student
populations to verify

EMIS



Not Properly Certified — Credential/Course, cont’d

Could be a career technical course that requires an override
* VM overrides are now automated

* Questions regarding CTE overrides can be sent to
* CTETeacherOverride@education.ohio.gov

* Will continue to be not properly certified on the TLCS Report

EMIS
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Not Properly Certified — Credential/Course, cont’d

* ODE ITC EMIS Training (Nov. 2022) Q/A

Q1. IF a CTE teacher is on the TLC Status Report as not properly certified, do we need
to request a CTE override for that teacher?

 Al. Remember that the override allows the funding to flow but does not change that
the teacher is not properly certified. These overrides impact your CTE FTE report, not
your Teacher Licensure Course (TLC) Status Report; teachers will continue to appear
as not properly certified even when an override is granted.

* Q2. | have teachers teaching courses without the appropriate credential. In the
second semester, the teachers will change to those with proper licensure. Will that
be reflected correctly in the Final Staff and Course (L) Collection?

* A2. Yes, the Final Staff and Course (L) Collection will have those teachers reported;
however, remember that the TLC Status Report only uses data reported in the Initial
Staff and Course (L) Collection. If the teacher change is not reported in the initial
collection, the new teacher will not be reflected on the report.

EMIS
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Not Properly Certified - Substitute

Substitute Credential for traditional districts

Filter on TLC Result Code TLO0O7 (Fatal)

* A long-term substitute can appear as properly certified when reported
by a community school

 Substitute teachers who are providing instruction and assigning grades
should be reported as the teacher of record, even if the teacher will be

@ Credentials
+i2 CREDENTIAL STATUS EFFECTIVE DATE ISSUE DATE EXPIRATION DATE CREDENTIAL NUMBER
=| 5 Year Long Term Substitute Multi Age (P-12) License m 07/01/2018 07/10/2018 06/30/2023 21587622

Teaching Fields Issue Date
French [060230] 07/10/2018
EMIS
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Not Properly Certified - Org IRN

Org IRN Not Matching

| ,' Filter on TLC Result Code TLO0OS8 (Fatal)

 Questions about these situations should be directed to the Office of
Educator Licensure

¥ Credentials

+t CREDENTIAL STATUS  EFFECTIVE DATE ISSUE DATE EXPIRATION DATE CREDENTIAL NUMBER
= 4 Year Alternative Resident Educator Designated Subject (Grades K-12) License m 07/01/2019  05/14/2019 06/30/2023 21701337

Valid In Organization: ESC of Central Ohio [046938]

Teaching Fields Issue Date

English [050000] 05/14/2019

Visual Art [020015] 05/14/2019

“ \ 12/08/2022
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| Not Properly Certified — Grade Level

. Students Outside Grade Range for Credential
|
|

|/
Filter on TLC Result Code TLO009 (Fatal)

| * More than 50% of students enrolled must be within the grade levels

on the teacher’s credential |
¥ Credentials

e CREDENTIAL STATUS EFFECTIVE DATE ISSUE DATE EXPIRATION DATE CREDENTIAL NUMBER

e ~

| = 5 Year Professional Elementary (1-8) License m 07/01/2018 03/22/2018 06/30/2023 21512322 .
These credentials
‘ Endorsements Issue Date
Reading K-12 [059902] 03/22/2018 a I IOW the teacher tO
§ Year Professional Kindergarten-Primary (K-3) License 07/01/2018 03/22/2018 06/30/2023 21512323
[ ]
= 5 Year Professional Elementary (1-8) License  Expirex 07/01/2013 04/26/2013 06/30/2018 20870652 tea C h Stu d e nts I n
Endorsements Issue Date g ra d es K-8
Reading K-12 [059902] 04/07/2014
I 5 Year Professional Kindergarten-Primary (K-3) License 07/01/2013 04/26/2013 06/30/2018 20870651
5 Year Professional Elementary (1-8) License 07/01/2008 04/08/2008 06/30/2013 20213662
5 Year Professional Kindergarten-Primary (K-3) License 07/01/2008 04/08/2008 06/30/2013 20213663
5 Year Professional Elementary (1-8) License 07/01/2003 04/18/2003 06/30/2008 3236647

\ 12/08/2022



Not Properly Certified — No Staff Course Record

No Staff Course (CU) Record

Filter on TLC Result Code TLO010 (Fatal)
* Teacher name will not appear on the TLC Status Report

| * Check Level 1 Validations for fatal or dependent errors
L that could cause the Staff Course (CU) Record to not be
reported

* Check for State Staff IDs that contain lower case letters

* Check for missing CJ records from a contracted staff
reporting relationship



Quick Check

The TLC Status Report
performs teacher certification
checks using your EMIS data,
as well as data from other
LEAs, against the CORE
database. Verify that your
data is correct prior to the
close of the Initial Staff and
Course Collection.

* Are you reviewing the TLC Status
Report regularly?

* Are you reporting data accurately
to EMIS?

* Are you working with district staff
to verify the data?

EMIS
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TLCS Excel Tips




Color Fill and Sort

* Review the report by teacher
* Clear all filters
* Data tab > Sort by Proper Cert Flag column (A-Z)

* Highlight all rows with Proper Cert Flag = N
e Color Fill — select a color ©

| * Select Cell A1
» * Data tab > Sort by Last Name and First Name

* Scroll through report and note-
e Staff member’s courses are showing as properly certified
 Staff member’s courses are showing as not properly certified
(highlighted rows)
 Staff member’s courses are appearing with some courses properly
certified and some not properly certified (non-highlighted rows)

iy
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Pivot Table — Proper Cert Flag by Teacher

Create Full Name Column using Concatenate

* Select co
* Right clic
 Select ce
* Select ce

umn K
kK and select “Insert”
| K1, add title “Full Name”

| K2

e Enter the formula =CONCAT(H2," ", 12, " ", J2)
* Copy formula down (double-click or drag down + in corner of cell)

e Select co
* Right clic
* Right clic

umn K
< and select “Copy”

< again and select - Paste Value 123 icon

EMIS
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Verify Teacher Course Pivot Table - Proper Cert Flag

Create Pivot Table

* From Insert Tab, select Pivot Filters Columns
Table PROPER CERT FLAG =~

e Select OK

e Pivot Table Fields to select:

e Columns Rows Values

» PROPER CERT FLAG T
* Rows

* FULL NAME

e **QOptional CALCTLCIRN
* Values

e Count of TCHR STATE ID

v Count of TCHR STATEID -

Defer Layout Update

* Filters EMIS
e ** Optional CALCTLC IRN o 3

Alliance



Verify Teacher Course Pivot Table, cont’d

A B C D

Verify Total by Teacher

 Why is the teacher certified
in some courses but not 5 999999999

7 | BG1032044

OtherS? g | BW1000441

9 §DF1000541 2

1

2

3 | Count of TCHR STATE ID||Column Labels ~
4 f Row Labels AN

e Does the teacher have too B 1

12§ OH1041720

many courses? 13 | oH1202130

14§ OH1210909

* Do all teachers appear in the | sjoizome

16 | OH1239865
pivot table? 17 | OH1302861

18 | OH1317557 1
19 oH1318170 1
20| OH1345628 9
21| OH1411734 / | 1

\ Tip - Add “All Borders” from Home Tab EMIS

\
\

s L

| |o|k |k | w~ e |w|uv o= e o,

| 12/08/2022 ke i
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Summary

* The TLC Status Report contains both data to verify and issues
to correct

* Some issues can be corrected, and some are simply stating
the fact

* Work with district staff to verify that the data is both correct
and complete

* “No errors” does not necessarily mean that your data is
complete and accurate

* Use Excel functions to make troubleshooting easier

EMIS
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" Resources

 (TLCS-001) Teacher Licensure Course Status Report Explanation

e ODE Home > Data > EMIS > Documentation > EMIS Validation and
Report Explanations

e EMIS Manual
e ODE Home > Data > EMIS > Documentation > EMIS Manual

L | Credit Flex Information
N * https://education.ohio.gov/Topics/Ohio-Education-Options/Credit-Flexibility-Plan

\ EMIS
\
\ 12/08/2022 'w- 72
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Resources, cont’d

. * Educator Search
* https://core.ode.state.oh.us/Core4/ODE.CORE.Lic.Profile.Public.Ul/
 OH|ID Portal App - Educator Licensure and Records (CORE)

* Certification and Licensure Dictionary

* https://education.ohio.gov/Topics/Teaching/Licensure/Additional-
Information/Certification-and-Licensure-Dictionary

e Office of Educator Licensure
e 614-466-3593 or 877-644-6338
e educator.licensure@education.ohio.gov

* Your district staff and your ITC

\ 12/08/2022
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https://core.ode.state.oh.us/Core4/ODE.CORE.Lic.Profile.Public.UI/
https://education.ohio.gov/Topics/Teaching/Licensure/Additional-Information/Certification-and-Licensure-Dictionary
mailto:educator.licensure@education.ohio.gov
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Questions?

If you would like a certificate of attendance for this

training, you must complete the below feedback form
within 5 business days of this training
https://tinyurl.com/EA-District-Feedback

EMIS
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